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Обзор интерфейса LIGHTCONVERSE Tools  
 

 

 

 

 

 

Truss – библиотека траверс различных производителей 

Scaffold – библиотека строительных лесов 

Objects – библиотека объектов фурнитуры, музыкальных инструментов и т.д. 

Fixtures – библиотека светового оборудования (совместимая с LIGHTCONVERSE) 

3D Models – библиотека примитивов 

 

  

Имя проекта и его путь 
сохранения 

Главное меню 

Палитры библиотек 
элементов 

Быстрый поиск 
элементов 

Информационн
ое поле 

 

Компас для 
ориентации в 

3D 
пространстве 

Информационное поле 
активного элемента (название 

координаты, размер) 

Диспетчер 
элементов Библиотеки 

элементов 

Выделенны
й элемент 

Координатная 
сетка 
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Диспетчер элементов 
 

Панель диспетчера элементов позволяет сгруппировать объекты в группы, выбрать 

необходимые элементы, показать или скрыть их в 3D пространстве, а также 

заблокировать выбранные элементы.  

Диспетчер элементов имеет две закладки    

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

Название и тип 
выбранного 
элемента 

 
Название группы 
(количество эл. в 
группе) 

Блокирование элемента 

 

Показать – скрыть 
объект 

 

Добавление группы 

 

Добавление в новую 
группу Удаление группы 

 

Выбранный элемент 

 

Перемещение 
элемента по 
координатам X,Y.Z 

 
Вращение 
элемента по 
координатам X,Y.Z 

 

Смена цвета 

Замена элемента на 
другого 
производителя 

 

Функция “Array” 
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Манипулятор “Мышь” 
 

Управление манипулятором (мышью) осуществляется следующим образом: 

Компас – область на экране, находящаяся в правом нижнем углу, 

позволяет производить навигацию и перемещение по 

виртуальному 3D пространству.  

 

Для перемещения по виртуальному миру вправо, влево, а также для 

приближения/отдаления необходимо навести курсор на компас, нажать левую кнопку 

мыши и перемещать в нужном направлении. Вращение колеса мыши вверх/вниз 

перемещает камеру в плоскости, перпендикулярно экрану области разработки. 

Описание кнопок мыши 

 

 

 

 

 

 

 

 

 

Область виртуального 3D пространства 
 

В центре области виртуального 3D пространства находятся положительные 

направления координатных осей X,Y,Z X – красная, Y –зеленая, Z – синяя, там же 

находится и начало координат (Origin point), по умолчанию. Если выбрать любую 3D 

модель и выбрать в главном меню “Selection” > Set Origin To Object, то начало 

координат изменится. Центром координатных осей станет центр выбранной модели. 

Для сброса начала координат по умолчанию - Selection” > Reset Origin. 

Основная поверхность пространства расчерчена сеткой (размер и шаг сетки можно 

изменять в отдельном окне “Grid Size”, вызвав его в главном меню “View” > “Floor Grid 

Sizе”). При выборе Set Metric вид сетки меняется на метрическую и обратно в 

империал. 

  

Левая кнопка 

 

Поворот вправо, влево  

Приближение или отдаление 

 
Колесико мыши 

Наклон вперед и назад 

Правая кнопка 

Установка камеры по 

умолчанию 

 

5 кнопка 

Перемещение 

относительно 

курсора 
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Режимы работы LIGHTCONVERSE Tools  
 

LIGHTCONVERSE Tools имеет два основных режима работы:  

1) РЕЖИМ КОНСТРУКТОРА -  в режиме конструктора используется неограниченное 

количество элементов.  

По умолчанию запуск программы всегда происходит в режиме КОНСТРУКТОРА.  

2) РЕЖИМ СКЛАДА – в режиме склада работа производится с ограниченным 

количеством элементов. 

Чтобы перейти в режим СКЛАДА, необходимо в главном меню выбрать меню 

“Mode”>“Open Warehouse”. При этом появится диалоговое окно, в котором 

отобразится информация о наличии элементов, используемых в данном проекте. 

После закрытия информационного окна будет предложена функция выделения 

элементов, отсутствующих на складе. 

Чтобы использовать в своей работе режим склада, необходимо его 

предварительно заполнить соответствующей информацией о наличии 

парка конструктивных элементов и техники. 

Чтобы перейти в режим заполнения склада, необходимо зайти в меню “Warehouse”> 

“Edit Warehouse”, при этом в информационном поле отобразится “Warehouse/”.  

 

Работа дизайнера может проходить как в режиме конструктора, так и по мере 

необходимости можно переходить в режим склада. При этом, в дополнительном окне 

отобразится информация о недостающих элементах проекта. Все недостающие 

элементы будут выделены, что даст возможность перенести их в отдельную группу.  
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Калькулятор баланса в режиме склада 

 

Программное обеспечение LIGHTCONVERSE TOOLS имеет инструмент анализа 

баланса элементов (“Warehouse”>”Balance calculator”), который позволяет произвести 

опись недостающих элементов за определенный период времени. Для работы с этим 

инструментом необходимо заполнить склад. Для удобства использования склада на 

разных площадках или использования техники других фирм, можно создать много 

складов. Для этого отдельно имеется импорт и экспорт текущей базы элементов. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Окно калькулятора баланса 

 

Окно заполнения 
данных по складу 

 

Импорт Склада 

 

Кнопка сортировки 
элементов склада 

 

Название элементов 
и их количество 

 

Вывод спецификации по 
складу в текстовый файл 

 

Экспорт Склада 

 

Проекты 

 

Добавление 
проектов 

Выбор даты 
мероприятия 
(Double Click) 

 

Фильтр выбора 
баланса по дате 

Окно анализа 
данных 

Вывод данных в 
текстовый файл 
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Процесс работы 
 

Установка подложки картинки.  

Если имеются картинки планов, схем или чертежей, их можно загрузить как подложку 

к проекту. Это можно сделать в меню “File > import > jpeg, png”. Загруженную картинку 

можно изменить, увеличив или уменьшив ее масштаб. Для этого в Диспетчере 

элементов выбираем вкладку “Properties” и выбираем опцию “Size”. Откроется окно 

“Image Size”, где будут указаны реальные размеры картинки. Чтобы изменить 

масштаб, необходимо выбрать условно совпадающую точку на картинке с сеткой 

пространства (красного цвета). Эта точка - центр, от которого будет происходить 

масштабирование рисунка. Размер можно изменить комбинацией клавиш: 

Ctrl+колесико мыши”. Для более точной настройки необходимо зажать 

“Ctrl+Shift+колесико мышки”. После настройки картинки, для предотвращения ее 

перемещения рекомендуем ее заблокировать, нажав  в диспетчере элементов. 

Такую процедуру масштабирования можно выполнять и на вертикальной оси Z.  
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Построение конструкций из TRUSS 

В палитре элементов выбираем библиотеку TRUSS. Над рабочей областью появятся 

иконки универсальной библиотеки TRUSS, а также библиотеки других 

производителей конструкций.  

После выбора универсальной библиотеки откроется меню: тип траверс и их серия, 

разновидности элементов (Straight, Corner, Circle, Accessory, Structure) 

В Structure находятся собранные популярные конструктивы.  

 

 

 

После выбора нужного элемента в правом нижнем углу 

программы отразится дополнительная информация о 

элементе.   

При выборе элементов траверс одной серии включается возможность 

проектирования со снаппингом (англ. “Snap” – прилипание, стыковка). Это позволяет 

быстро установить нужный элемент без лишней подгонки. В процессе перемещения 

элементов система показывает ближайшие возможные варианты стыковки. 

 

Важно! Существует правило при снаппинге. Если выбрать группу элементов, то 

последний из них всегда является снаппингом (стыкующийся с другими элементами). 

Также есть возможность использования функциональных клавиш Q, 

W для поворота и смены снаппинга. Последний элемент имеет 3D 

манипулятор.  

При выборе каждого элемента или группы элементов появляется 3D 

манипулятор, который позволяет трансформировать объекты 

(перемещение, вращение, масштабирование). Также аналогичные 

операции можно произвести в Диспетчере элементов. 

 

Виды элементов 

Производители  

 

Типы траверс 

 Серия траверс 

 

Список элементов 

 

Последние цифры – это 
длина траверсы 
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При вставке элементов Corner, есть возможность оперативно разворачивать траверсу 

(клавиша W) и менять снаппинг элементов клавиша Q. 

 

 

Show truss point  Подсветка точек снаппинга 

Для удобства снаппинг элементов имеет подсветку в виде оранжевых точек. 

Подсветку можно отключить и включить в меню “View > Show truss point”.  

Если ваш компьютер не очень мощный, рекомендуем отключать функцию 

подсветки снаппинга (“View > Show Truss Point”). 

Align Angle – Выравнивание угла отклонений 

Для выравнивания отклонений, малых углов к прямым углам, элементов используйте 

опцию “Selection > Align Angle”.  

Flip – Зеркальное отражение объектов 

Зеркальное отражение элементов можно осуществить, выбрав в меню “Selection > 

Flip” по координатам X,Y,Z. Точкой отражения является центр группы траверс. При 

этом левые и правые элементы принимают правильные положения.  

Align selection to floor – Установка элемента на поверхность 

Для установки элемента в нулевое положение по горизонтали можно воспользоваться 

комбинацией “Ctrl+F”. 

  

Нажимаем Q – 
элемент 
вращается вокруг 
снаппинга 

 

Нажимаем W – 
элемент меняет 
снаппинг 
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Построение конструкций из Scaffold 

 

В палитре элементов переходим в библиотеку Scaffold.  

 

Построение лесов также происходит с возможностью снаппинга. При этом, если какой-

либо элемент не снаппится, это означает невозможность его установки в данном 

месте. 

Ledgers, Diagonal, Double Ledgers можно вращать вокруг элементов Vertical и 

Accessory клавишей Q. 

При установке Diagonals 3D манипулятор принимает положение угла наклона 

элемента. При этом перемещаться можно только вдоль осей. При необходимости 

перемещения такого элемента строго по ортогональным осям, необходимо зажать 

клавишу Shift и 3D манипулятор примет ровный вид, относительно осей X,Y,Z. 

 

 

 

 

 

Клавиша Shift изменяет 
направление 3D 
манипулятора 
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Использование 3D Objects, 3D Models 

 

В LIGHTCONVERSE TOOLS имеются 3D Объекты и 3D Модели. С их помощью можно 

добавлять в проект такие элементы как звуковые системы, модели людей, простые 

фигуры, декорации и многое другое. Также можно загрузить другие модели в формате 

(*.obj, *.x, (DirectX)). Окно импорта моделей можно найти в главном меню File > Import 

… При загрузке этих элементов, появляется диалог выбора масштаба, в котором 

будет происходить импорт.  

 

В случае загрузки моделей с текстурами, загрузка произойдет автоматически. А в 

случае отсутствия текстур уведомит соответствующим диалогом с перечнем 

недостающих картинок. 

При выделении 3D Объектов и 3D Моделей появляются дополнительные 

возможности в диспетчере свойств: 

 

  

Название и тип 
выбранной 
модели 

Перемещение 
модели по 
координатам X,Y.Z 

Вращение 
элемента по 
координатам X,Y.Z 

Смена цвета 
Установка 
прозрачности модели 
от 0 до 100% 

Конструктор 
построения массивов 
моделей 

Режим каркасного 
отображения 3D 
модели 

Режим отражения 
бликов 

 

Отражение 
поверхностей 
с двух сторон 

Отражение 
поверхностей наружу  

Отражение 
поверхностей во 
внутрь 
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Экспорт проекта в LIGHTCONVERSE 3D SHOW PLATFORM 
 

Для экспорта проекта в главном меню выбираем “File> Export> Export to 

LIGHTCONVERSE”. Имеется возможность произвести экспорт только выбранных 

элементов (Export Selected) и экспорт всего проекта (Export All). Формат файла для 

экспорта будет иметь разрешение (*.3dl). При этом все конструктивные элементы, 3D 

объекты и световые приборы упаковываются и сохраняются в один файл. 

Перед экспортом желательно проверить верное нахождение центра мира, так как 

выбор центра будет влиять на импорт в LIGHTCONVERSE.  

 

Импорт (*.3dl) в LIGHTCONVERSE 3D SHOW PLATFORM 

 

Импорт проекта в LIGHTCONVERSE происходит в два шага:  

1 шаг – импорт объектов в режиме Room 

2 шаг – импорт световых приборов в режиме DMX 

Импорт объектов в режиме Room (шаг 1) 

Перед импортом в LIGHTCONVERSE в режиме Room необходимо настроить центр 

мира (WORLD CENTER) на “FLOOR”. Для этого выбираем floor и нажимаем WORLD 

CENTER. Также желательно выставить размеры помещения (Room Size) 

необходимые для вашего проекта. 

 

Далее можно импортировать объекты 3D сцены Вашего проекта. Для этого 

устанавливаем курсор в списке объектов на 1 строчку или в нужную вам позицию и 

выбираем кнопку Browse 3D-Model > Explorer  

 

 

Кнопка для Импорта 
3D-Model 

Установить курсор в 
нужную позицию для 
импорта 



 

14 

Импорт световых приборов в режиме DMX (шаг 2) 

Для импорта световых приборов переходим в режим DMX. Устанавливаем курсор в 

списке объектов на 1 строчку или в нужную вам позицию и выбираем кнопку Import> 

Explorer 

 

 

Световые приборы выбираются и заменяются на реальные приборы из списка базы 

LIGHTCONVERSE.  

 

  

Кнопка импорта 
световых приборов 

 

Установить курсор 
в нужную позицию 
для импорта 
световых приборов 
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Режим Ruler  
 

Для выбора режима “ЛИНЕЙКА” в главном меню выбираем “Mode> Ruler”. Программа 

переходит в режим линейки и оповещает пользователя всплывающей надписью по 

центру экрана (Ruler Mode), все лишнее при этом исчезает. Появляется диспетчер 

линейки.  

 

 

Эта линейка является параметрической, она привязывается к точкам объекта и 

позволяет вести измерения в процессе перемещении объекта в режиме Конструктора. 

Выход из режима линейки осуществляется нажатием клавиши Esc или нажатием на 

экране информационного сообщения: “Ruler mode. Click here or press Esc to exit” 

  

Выбор крайних точек 
линейки снаппинг: 

1. Центры элементов 

2. Крайние точки 

элементов 

3. Произвольно 

Линейка и длина 

Удаление линейки и 
изменение цвета 
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Режим DMX Patch  
 

В режиме DMX Patch у пользователя есть возможность назначить адресацию 

световым приборам по протоколу DMX512, и вывести ее на чертеж для печати. 

Назначенные адреса сохраняются при экспорте проекта в LIGHTCONVERSE. 

Для выбора режима “DMX Patch…” в главном меню выбираем “Mode> DMX Patch…”. 

Программа переходит в режим DMX Patch и оповещает пользователя всплывающей 

надписью по центру экрана “DMX Patch Mode Click here or press Esc to exit”. 

Во время патчинга приборы можно выбрать как в 3D пространстве, а также и в окне 

DMX patch . Все приборы имеют заданные каналы. 

В окне DMX Patch имеются две закладки:  

Table View – табличное представление адресного пространства 

Universe View – графическое представление адресного пространства 

В Table View назначение адресов приборам происходит в порядке выбранным 

пользователем. Выделение приборов может быть одиночным и групповым. 

Табличный вид позволяет сортировать по заголовкам.  

 

 

 

Unit Number – порядковый номер прибора, заданный программой по мере вставки их 

в проект 

User ID – номер для использования в профессиональных световых консолях  

Firm – производитель светового прибора 

Name -имя светового прибора 

Universe – выбор линии (вселенной) 

Channel – адрес прибора 

Address – Абсолютный адрес 
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После выбора группы световых приборов нажимаем клавишу      Patch      . В окошке 

Patch Properties имеются следующие опции: 

  

 

 

 

 

 

Приборы, получившие адрес, перемещаются на вверх по списку и меняют цвет на 

темный. 

В закладке Universe View можно увидеть патчинг в графическом виде. Световые 

приборы можно перемещать по адресам. 

 

 

  

Смещение с пропуском 
на значение __ 

Автоматический переход 
на следующую линию 
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Конструктор создания листов печати. (PaperWork) 
 

Для надлежащего оформления проекта имеется возможность создания листов 

печати.  

Конструктор создания листов печати – это виртуальный аналог печатного листа с 

возможностью создания разных видов проекта, добавления аннотаций, ссылок, 

информационных таблиц, элементов оборудования и др.  

Чтобы открыть конструктор листов печати, необходимо выбрать “Mode” > “Paperwork…” 

Сохранение листов печати осуществляется в собственном формате *.LCR, 

а также для электронного обмена в формате *.PDF. Созданный или 

измененный чертеж следует предварительно сохранить, в противном 

случае все изменения будут утеряны. 
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Этапы создания листа. 
 

При выборе опции “Mode” > “Paperwork” открывается диалог “Report Options” 

 

 

После выбора необходимых опций Viewport загружается на лист, где можно выбрать 

его размер и положение на листе. При этом, если включена опция “2D icons”, 

загружаются элементы типа Fixture, которые можно редактировать. При 

необходимости можно загрузить другие виды проекта через меню “Edit > Load Jpeg”.  

Перед открытием модуля редактирования и печати листа необходимо выбрать 

положение камеры 3D пространства. Для настройки ортогональных проекций 

необходимо установить камеру в 0 градусов. Это можно сделать, нажав Ins (NumPad), 

для отмены - повторно Ins (NumPad),.  

После открытия модуля редактирования листа необходимо настроить параметры 

листа. 

Панель атрибутов рамки 
 

Для изменения формата листа и его ориентации необходимо нажать на границе листа 

правую кнопку мыши.  

 

Количество созданных листов зависит от поставленной задачи. Для добавления 

новых листов в проект необходимо выбрать внизу проекта кнопку , для удаления 

листа - кнопка   . Выбор листов осуществляется выбором соответствующих 

закладок. 

Опция включения рендера 
окна просмотра (Viewport) 

Для рендера всех видов 
проекций 

Для рендера проекционного 
вида (Спереди, слева, 
справа, сверху, снизу, сзади,)  

Для рендера в каркасном 
виде (Wireframe) 
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Настройка данных рамки листа 
 

Для заполнения рамки данных листа печати необходимо зайти в “Edit” > “Report 

Options”. Всю информацию можно сохранить для использования на других листах. 

 

 

 

Палитра инструментов 
 

Все манипуляции для работы с листом происходят с помощью Палитры 

инструментов. Палитра инструментов имеет следующие возможности: Add Note, Add 

Text, Add Size, Add Patch, Add Table, Add Report Options, Add Fixture. Многие 

инструменты имеют свойства настройки и редактирования. 

 

Описание палитры элементов 

 

 
Open Project 

 
Save Project 

 
Save Project As.. 

 
Undo 

 
Redo 

 
Pan 

 Zoom 

 
Zoom All 

 
Load JPEG file 
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Add Note 

 
Add Text 

 
Add Size 

 
Add Size Arrow 

 Add Size Dot 

 Add Size Slash 

 Add Patch 

 Add Patch without Edging 

 Add Patch with Edging 

 Add Table 

 Add Fixture Key Table 

 Add Trusses Table 

 Add Scaffold Table 

 Add Fixture Table 

 Add Report Options 

 
Add Fixture 

 
Save Sheet(s) to PDF File 
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Горячие клавиши 
 

Ctrl + Z –  Undo action Ctrl + X – Redo action 

Ctrl + Y – Redo action 

Ctrl + D – Duplicate selected unit(s) 

Alt + Arrows – Duplicate selected unit(s) in relative direction 

Enter – Locate object to highlighted (flashing) area 

Ctrl + Enter – Copy and locate object to highlighted (flashing) area 

 

Q –  Change free connection junctions of selected truss 

W – Rotate the selected elements at connection point of trusses 

  

Mouse Wheel Scrolling Actions: 

 - Use scroll wheel on Compass area – Tilt camera  

 - Use scroll wheel on scene area – Move camera up/down 

 - Use scroll wheel in the library – Scroll through library elements         

 - Use scroll wheel on selected element axes – Rotate the element      

 
- Use scroll wheel + Ctrl in 3D Substrate Size and Image Size – 
Change size of 3D models and images  

 
- Use scroll wheel + Ctrl + Shift in 3D Substrate Size and Image 
Size – Change size of 3D models and images smoothly 

 

Ctrl + A - Select all objects 

Esc 
– Deselect all objects (also exit Ruler mode, 3D Substrate Size 
mode, Warehouse and Image Size mode) 

Delete – Delete all selected objects 

Space – Center camera on selected objects 

Left Arrow – Move camera left 

Right Arrow – Move camera right 

Up Arrow – Move camera up 

Down Arrow – Move camera down 

Home – Move camera forward 

End – Move camera backward 

Shift + Arrow – Slow camera motion 

1-9 – Navigate camera to standard positions 

Insert – Toggle to perspective/orthogonal view 

Left Mouse Click – Single selection 

Ctrl + Left Mouse 
Click 

– Add to multiple selection 

Alt + Left Mouse 
Click 

– Remove from multiple selection 

 
 

Double Left Mouse 
Click 

– Multiple selection of continuously connected units 
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Double Right Mouse 
Click 

– Multiple selection  

Ctrl + Left Mouse 
Click 

– Select main unit from already selected units 

Ctrl + S – Save in file 

Ctrl + Shift + S – Save As to project file 

Ctrl + O – Open a file 

F12 – Toggle visibility of navigator 

Ctrl + R – Reset angles 

Ctrl + F – Align selected unit with the floor 

Ctrl + Alt + N – Show truss name 

Ctrl + L – Show a library window 

Ctrl + Alt + C – Show truss color 

Ctrl + Alt + M –  Toggle Imperial/Metric measurement system 

Ctrl + Alt + R – Rip apart 

Alt + F4 – Exit  

 

 

Меню основного режима 
 

File   

New... Создание нового проекта .lctools 

Open... Открытие проекта .lctools 

Open Recent Открытие проекта из списка 10 последних проектов 

Save Сохранение проекта .lctools 

Save... Сохранение проекта .lctools под другим именем 

Import   

.lctools Импорт проекта в текущий проект 

.x Импорт *.x файла в проект  

.obj Импорт *.obj файла в проект  

.jpg Импорт *.jpg файла в проект  

.png Импорт *.png файла в проект  

Export   

  Экспорт проекта в .3dl файл 

  Экспорт выбранных объектов проекта в .3dl файл 

View   

Show Window Library 

Переключатель библиотеки по траверсам в виде дерева (windows style) и всех 
библиотек (Truss, Scaffold, Objects, Podiums, Fixtures, 3D Models) в виде 
закладок (Direct X graphic style) 

Show Group Window Показать/Спрятать окно групп 

Show Navigator Показать/Спрятать навигатор камеры 3D мира 

Show Truss Names Показать/Спрятать имена возле траверс и лесов в 3D мире 

Show Truss Points Показать/Спрятать места соединений траверс и лесов в виде светящихся точек 

Show Detect Collision 
Показать/Спрятать импульсное подсвечивание красным цветом объектов при 
полном совпадении положений в пространстве по категориям (Truss, Scaffold) 

Show Floor Grid Показать/Спрятать сетку на полу 

Floor Grid Size... Редактировать размер сетки на полу 

Set Imperial/Set Metric Переключение английской и метрической систем координат 

Paper Переключение в отображение 3D вида на белом фоне 
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Camera   

Top Вид сверху 

Back Вид сзади 

Front Вид спереди 

Left Вид слева 

Right Вид справа 

Top Front Right Изометрический вид сверху, спереди, справа 

Top Front Left Изометрический вид сверху, спереди, слева 

Top Back Right Изометрический вид сверху, сзади, справа 

Top Back Left Изометрический вид сверху, сзади, слева 

Perspective Включить/Отключить перспективу 

Focus to selection Подлет камеры к выбранному объекту с аксисом 

Reset Сброс камеры, начальное положение 

Edit   

Undo Отменить последнее действие 

Redo Повторить отмененное действие 

Selection   

Reset Angles Сбросить все углы поворотов объекта 

Align Angle Выровнять наименьший угол поворота к прямым углам 

Align selection to floor Выровнять объект по полу 

Duplicate Дублировать 

Deselect Снять выбор с избранных объектов 

Select All Выбрать все объекты 

Delete Удалить выбранные объекты 

Select Collision Выбрать объекты находящееся в коллизии 

Flip 
Построить симметричную структуру из выбранных элементов с учетом замены 
объектов на их аналоги 

Flip X Local Относительно минимального X значения BoundBox'а структуры 

Flip Y Local Относительно минимального Y значения BoundBox'а структуры 

Flip Z Local Относительно минимального Z значения BoundBox'а структуры 

Flip X Global Относительно плоскости YZ 

Flip Y Global Относительно плоскости XZ 

Flip Z Global Относительно плоскости XY 

Set Origin To Object Установить значение «Центр мира» в позицию аксиса выбранного объекта 

Reset Origin Сброс значения «Центр мира» в 0, 0, 0 

Report   

Camera View To Jpeg... Сохранение вида камеры в .jpg файл 

Specification... Сохранение спецификации в .txt файл 

PDF... 
Сохранение вида камеры на белом фоне с основным штампом (таблицей) с 
информацией о проекте в .pdf файл 

Jpeg with comments... 
Сохранение вида камеры c текстовой информацией (комментариями) в .jpg 
файл 

PDF Report... Переход в режим конструктора печати и оформления листов 

Help   

About Показать окно About со списком горячих клавиш 
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